
En este primer artículo de una serie

de tres, el ex-director artístico de un

periódico, Jason Walsh, echa un vis-

tazo a la autoedición en Linux. Jason

creará un periódico usando Scribus

junto con otras aplicaciones Linux y 

lo probará en una editorial real.

POR JASON WALSH

Maquetación en Linux con Scribus

Un Periódico en Linux
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La clave del incremento de la pene-
tración industrial de Linux no ha
sido en el uso generalizado de orde-

nadores, sino que ha sido gracias la
invasión sistemática en distintos nichos,
notablemente en los servidores web, cál-
culo científico y desarrollo de aplica-
ciones. Es indiscutible que ha sido un
rotundo éxito. En la actualidad a Linux
le pertenecen varias áreas claves de la
informática.

Una de las áreas en las que Linux no
ha hecho grandes avances es en el
mundo de la autoedición, una industria
que pertenece casi exclusivamente a
Apple Macintosh. Después de años de
dirigir a los usuarios potenciales a sis-
temas complejos y poco extendidos
como LaTeX, Linux por fin tiene una

excelente herramienta WYSIWYG de
escritorio para la autoedición.

En esta serie produciremos cuatro
hojas de periódico de prueba bajo Linux
que serán evaluadas por David Hunter
del departamento de preimpresión del
Belfast News Letter, la más antigua pu-
blicación diaria continuada en lengua
inglesa del mundo.

Podríamos decir que esta mini-edición
equivaldría al “Hello World” de la
autoedición de escritorio de Linux.

Historia de la Edición
Anteriormente a la aparición de sistemas
de escritorio WYSIWYG para la edición,
la producción de periódicos y revistas
era un complicado y arcano proceso que
implicaba equipos especializados como
máquinas de linotipia, cámaras de proce-
sos e impresoras de bromuro. El interfaz
de usuario gráfico del Apple Macintosh y
su primera aplicación estrella,
Pagemaker, lo cambió todo para siempre.
Después de siglos, la maquetación era
accesible para cualquiera, al menos a
cualquiera que pudiera permitirse un
Mac y una copia de Pagemaker.

El dominio de Pagemaker ha declinado
hasta el punto de ser casi un producto
usado en las empresas exclusivamente

para crear boletines de noticias. La apli-
cación más importante en el mundo de
la edición profesional es Quark XPress. A
finales de los noventa, un serio rival retó
a Quark llegado desde Adobe: InDesign.
InDesign ofrecía la mayoría de las carac-
terísticas de Quark XPress, además de
otras muchas que no tenía Quark, todo
con el interfaz de usuario de Adobe, que
los diseñadores ya conocían gracias a
Photoshop e Illustrator. Ni Quark ni
InDesign se encuentran disponibles para
Linux, ni tampoco parece que sea proba-
ble que lo vayan a estar en breve.

Presentamos Scribus
Sin embargo aún no está todo perdido.
Siguiendo la tradición del “código abier-
to”, cuando una aplicación no está
disponible, un grupo de programadores
se reúnen para producir una alternativa
gratuita. Esa alternativa es Scribus
(véase la Figura 1).

La instalación de Scribus es razonable-
mente sencilla, desafortunadamente no
hay paquetes binarios universalmente com-
patibles, pero compilarlo es bastante fácil:

./configure
make
make install

Antes de la etapa RIP, habrá que exportar
nuestras páginas a ficheros PDF. Los PDF de
Adobe se han convertido en los formatos
estándar para el intercambio de documen-
tos impresos; si su PDF se crea de forma ade-
cuada, se podrán imprimir en un amplio
rango de dispositivos de salida, incluyendo
impresoras de chorro de tinta, prensas digi-
tales y prensas offset de cuatro colores.

Salida



Luego se configura. Alternativamente,
están disponibles para los sistemas Red
Hat paquetes RPMs, y también están
soportados Gentoo y Debian.

Creación de Páginas
Para nuestro proyecto vamos a trabajar
con unos requerimientos específicos pre-
definidos. El resultado final será un cier-
to número de páginas para un periódico.
El primer paso es definir la forma y el
tamaño de la página, junto con algunos
otros parámetros comunes: márgenes y
columnas.

La Figura 2 muestra el cuadro de diálo-
go de las propiedades de maquetación de
Quark XPress 6 en el Mac OS X (Layout
> Layout Properties). Si se está pasando
a Scribus desde Quark, el primer paso es
copiar estos datos básicos e introducirlos
en Scribus. Si se está creando una nueva
maqueta, hay que definir las
propiedades equivalentes.

¿Por qué no se importa la plantilla
original de Quark a Scribus? Porque
lamentablemente Scribus no puede
importar ficheros de otras aplicaciones
de maquetación. Tal y como dicen los
desarrolladores, “los formatos de
ficheros DTP son internamente muy
complejos, probablemente los más com-

plejos en un PC. Crear los filtros para
importar/exportar es una tarea mucho
más compleja que la de importar los for-
matos de ficheros de una hoja de cálculo
o de un procesador de textos”.

Esto es un impedimento, pero es un
problema común. Adobe InDesign puede
abrir ficheros de Quark 4 pero no de
Quark 5 o 6. Quark no puede abrir
ningún fichero de InDesign, ni siquiera
Quark versión 6 puede “guardar como”
versión 4. Siguiendo un grado de cordura
con respecto a la apertura de archivos
que parece que ni Quark ni Indesign
muestran, Scribus usa el estándar XML
para su formato de fichero nativo. Esto
significa que será posible abrir los
ficheros de Scribus en otras aplicaciones
de maquetación en el futuro.

“Tabloid” (el formato de página que
vamos a usar para el periódico) en
EE.UU. se refiere a un tamaño específico
de página de 279.4mm x 431.8mm. En
Europa, es un término más o menos
genérico que se refiere a una página de
periódico de un tamaño aproximado a
un A3, la mitad del tamaño de la hoja
completa, a todo lo ancho, que compone
el periódico.

El cuadro de diálogo New Document
en Scribus es donde la página básica se

crea inicialmente (véase la Figura 3). La
página que vamos a crear servirá de
plantilla para las siguientes (y de hecho,
para todas las demás, aunque ligera-
mente modificadas). Nuestras plantillas
van a ser muy básicas, simplemente se
definen el tamaño y la forma de la pági-
na y si van a tener márgenes.

Nuestro proyecto será de 297mm x
386mm; bastante parecido al tamaño de
hoja del periódico inglés Independent y
algo diferente de la mayoría de los
“tabloids”. Así pues pondremos en el
ancho 297mm y en el alto 386mm.

La impresión al filo de la página es
bastante común en las revistas, pero es
bastante raro en los periódicos ya que las
prensas no son capaces de realizarlas.
Incluso cuando son capaces, nunca se
usan en la página delantera. Hay que
definir un área imprimible y lo hacemos
estableciendo los márgenes en el cuadro
de diálogo New Document. Estas
propiedades son definidas por el periódi-
co y difieren de unos a otros. En nuestro
caso, los márgenes los estableceremos
en: Top, 29mm; Bottom, 16mm; Inside,
8mm; Outside 23mm.

Los márgenes se han establecido de
forma desigual para crear una zona rec-
tangular de 265mm x 340mm: ésta es el
área mínimamente imprimible en la
posición correcta.

En algunas páginas los elementos
pueden salirse de este rectángulo inicial;
en otras palabras, podrían no impri-
mirse. Esto es un asunto de paginación e
imposición que es, de nuevo, impuesto
por el periódico y no por el diseñador,
así que no vamos a discutirlo en detalles
aquí.

Dentro de este rectángulo central,
definiremos más tarde nuestra maque-
tación principal basada en cinco colum-
nas de texto. Scribus maneja las colum-
nas de manera diferente a como lo hacen
otras aplicaciones DTP (se verá más ade-
lante) pero el diseño es eficiente y muy
manejable.

El cuadro de diálogo “New Document”
tiene otras opciones: marcos de texto
automáticos rellenan el área imprimible
con un marco de texto en cada página
nueva, útiles para la creación de grandes
documentos como diseños de libros,
pero sin relevancia aquí.

El resto de las opciones son relativas a
la impresión. Hay que asegurarse de que
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Figura 1: Scribus ejecutándose en Suse 9.1. Por fin, una aplicación de maquetación con calidad profe-
sional llega a Linux.



tria. Por extraño que parezca,
hay cientos de publicaciones
que no cuentan con un departa-
mento de TI; con sistemas basa-
dos en Mac, simplemente no
necesitan tener dentro de la
empresa un departamento de
TI.

La principal objeción a
Scribus parece estar en su uso:
la maquetación basada en mar-
cos; es decir, todos los objetos
están contenido dentro de un
marco y pueden ser manipula-
dos de dos formas: como un
objeto o como un contenido.

Esta forma de trabajo es
común tanto en Quark como en

InDesign y de hecho es una forma muy
eficiente de separar diseño de contenido.
Más aún, es esencial para Scribus el ofre-
cer un entorno cómodo para impresores
profesionales, ya sean diseñadores, peri-
odistas o subeditores, si lo que se pre-
tende es introducirse de forma seria en el
mundo de la edición.

Una vez que uno se acostumbra a ello,
esta forma de trabajar es bastante pro-
ductiva: para situar el texto en la página,
primero se debe crear un marco de texto,
luego se inserta o se teclea el texto den-
tro del marco. Para colocar una imagen
en la página, se crea un marco de ima-
gen y luego se importa la fotografía o el
gráfico dentro de este marco. De esta
forma, los marcos y los contenidos que
albergan pueden ser manipulados inde-
pendientemente.

Gestión del Color
La impresión es más un arte que una
ciencia y es perfectamente posible
saberlo todo sobre ella y aún así
enfrentarse a un desastre en el periódi-
co. Hay demasiadas
variables para ser
sinceros, y muchas
de ellas no pueden
ser controladas
desde el escritorio.
El tipo y grado del
papel a usar, la cali-
dad y la viscosidad
de la tinta, el tipo y
los años de la
imprenta y la habili-
dad de los impre-
sores tendrán todos

se marca la opción “Facing Pages” que
hace que la maquetación corresponda a
una disposición de dos páginas de
ancho.

Cuando las páginas se imprimen, se
hacen en pares. La de delante y la de
atrás lo hacen juntas y se doblan por la
mitad y cubren a las siguientes y así con
todas. Un periódico completo se forma a
partir de varios ficheros con distintos
números de páginas, en vez de hacerse
con un solo fichero que contenga el pe-
riódico entero. Esto permite que dife-
rentes páginas puedan ser creadas en
momentos diferentes (y por personas
diferentes) e impide que los ficheros de
Scribus lleguen a ser tan grandes que no
se puedan manejar.

Maquetación Basada en
Marcos
Algunos de los críticos de programas de
código abierto se han quejado del inter-
faz de Scribus, criticando que no es muy
apropiado para los usuarios domésticos.
Esta es una crítica bastante extraña, ya
que este software está enfocado a usua-
rios profesionales. Tanto Quark XPress
como Adobe InDesign no son nada intui-
tivos para los usuarios amateurs, pero la
publicación es un mundo complejo…
esto no es un procesador de textos.

Uno de los grandes problemas a los
que se enfrenta Scribus es al hecho de
que no dispone de una versión binaria
estable universalmente compatible.
Esperar que los diseñadores y periodistas
compilen software desde los fuentes es
ridículo y es un serio impedimento para
que Scribus sea adoptado por la indus-
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unidos un efecto global sobre el resulta-
do final.

Una de las áreas que es más difícil de
conseguir es la reproducción del color y
aunque todos los elementos nombrados
anteriormente tendrán un impacto, es
importante asegurarse que antes de
enviarse los ficheros a la imprenta que
sean de tan alta calidad como sea posi-
ble.

El color es un tema sorprendente-
mente complejo. La gestión interna del
color fue una de las mayores ventajas
jugadas por los Macintosh como
plataforma de impresión… y una de las
mayores desventajas de Linux. Hasta
ahora.

La gestión del color es una tecnología
que se usa para calibrar el color de los
dispositivos de entrada, los monitores y
los dispositivos de salida. La clave prin-
cipal es el “espacio de trabajo”. Esto es
una referencia de color que no está liga-
da a ningún dispositivo específico,
comúnmente “sRGB”, un perfil básico de
adición del color adecuado para los mo-
nitores. El problema que representa es
que los dispositivos de salida, ya sean el
monitor o la impresora, deben hacer una
transformación desde sRGB a su espacio
nativo de color y la calidad de esta trans-
formación será determinada por la cali-
dad del driver del dispositivo.

Un método mejor es el uso de un sis-
tema de gestión de color compatible
con el “International Color
Consortium”. El ICC define un estándar
abierto para los módulos de coinciden-
cia de color, preferiblemente definidos
a nivel del SO y perfiles de colores
tanto para los dispositivos como para el
espacio de trabajo.

La tecnología de gestión del color
puede ser implementada por el sistema

Figura 3: El cuadro de diálogo New Document de Scribus. En este diálogo
se define la forma básica de la página. Hemos usado aquí los parámetros
usado por EBO tomados de Quark XPress.Hugin.

Figura 2: El menú de las propiedades de la página en Quark
XPress muestran los parámetros por defecto del East Belfast
Observer.



operativo, en la API, o directamente por
la aplicación. Desde hace años, Mac OS
ha incluido un software de la propia
Apple para la gestión del color,
ColorSync. Actualmente Linux cuenta
con una solución compatible denomina-
da LittleCMS. Los usuarios domésticos
puede ser que no necesiten instalar
LittleCMS, pero para los usuarios profe-
sionales es obligatorio.

LittleCMS incluye perfiles de color
estándar ICC y una vez instalado
LittleCMS, los ficheros PDF producidos
por Scribus serán impresos tal y como
aparecen en pantalla. Sin él, habrá que
estar adivinando como quedará un color
dado al imprimirse.

Es importante entender que LittleCMS
no es una aplicación propiamente dicha,
sino más bien, es una biblioteca de pro-
gramación que puede utilizarse en el
desarrollo de aplicaciones y Scribus es
una de las aplicaciones que la usan. Si se
instala antes de instalar Scribus, Scribus
automáticamente la usará.

Desafortunadamente, en Linux, el
único programa de retoque fotográfico
que soporta gestión del color es Corel
Photopaint. Esperemos que las bondades
de LittleCMS sean aprovechadas por los
desarrolladores de GIMP antes de que se
les escape el tren.

El aspecto más importante a la hora de
usar un sistema de gestión de color es
recordar activarlo. Cuando llegue el
momento de exportar nuestros PDFs
finales, volveremos sobre esto en detalle,
pero por ahora se puede echar un vistazo
en File>Export>Save Page as PDF. En el
cuadro de diálogo que aparece, hay que
seleccionar la solapa color. Si se tiene
LittleCMS instalado, se verá un menú
desplegable bajo PDF/X-3. Este menú
contiene los perfiles de impresión.
Consúltese la impresora y selecciónese el
más relevante.

En nuestro caso de prueba, el perfil
correcto va a ser Euroscale Uncoated v2.

Porque Euroscale es un intento para pro-
porcionar un perfil genérico para
Europa. Opciones para América del
Norte y Japón están también
disponibles, Web/SWOP y Japan Color
respectivamente, así que si usted vive en
América o Japón, el escoger el perfil ade-
cuado le proporcionará los mejores
resultados. Uncoated se refiere al tipo de
papel; muchas revistas se imprimen en
papeles caros con brillo, pero no los pe-
riódicos.

Para saber que gestor del color es
esencial, es necesario comprender los
principios básicos de la impresión offset,
ya que difiere de forma significativa de la
impresión por chorros de tinta.

La impresión offset, litografía, es el
proceso con el que se imprimen los pe
riódicos. Los ficheros se pasan por un
RIP o Raster Image Processor, que lo
convierte en una imagen PostScript.
Cada página se convierte en una imagen
simple, que posteriormente se imprime
en una película y se transfiere a una
plancha de aluminio.

Esta plancha se fija a un
tambor que rueda a través de
una cubeta de agua. El agua
se adhiere a las partes negati-
vas de la imagen.
Posteriormente, la plancha
pasa por una cubeta de tinta,
que se adhiere a las áreas
positivas; el siguiente paso,
es hacer rodar un tambor de
goma sobre la plancha para
escurrir el agua y recoger la
tinta. Este tambor se hace
rodar sobre el papel para
transferir la tinta.

El color se imprime sepa-
rándolo en cuatro planchas
distintas, una para cada color
usado en el proceso de impre-
sión. Este proceso se denomi-
na separación del color. Para
que este proceso funcione de

forma correcta, los elementos con color
como fotografías y gráficos, deben estar
en el espacio de color CMYK. Las imá-
genes en las pantallas de los ordenadores
suelen estar en formato RGB, Rojo, Verde
y Azul. Estos  son los colores primarios
aditivos usados para formar colores
secundarios y terciarios con luz.

Pero con tintas, es necesario usar los
colores primarios substractivos, Rojo,
Amarillo y Azul. En impresión, son susti-
tuidos por Magenta, Amarillo y Cián,
que ofrecen una gama más amplia de
colores imprimibles. El orden en que los
colores son impresos es, primero el Cián,
luego el Magenta y por último el
Amarillo: CMY. La “K” viene de “Key”
(clave), que es el color de registro,
Negro. Sin la plancha final de negro, en
el resultado final los elementos en negro
como el texto, se verían como marrón
oscuro, púrpura o verde.

Si se imprime un fichero RGB en una
impresora de chorros de tinta, algunos
colores parecerán estar “fuera de la
gama”, esto es, fuera del rango de co-
lores imprimibles. Una inconveniencia,
pero no un desastre.

Si se está imprimiendo en una prensa
CMYK, es de vital importancia hacer
coincidir los colores RGB vistos en la
pantalla con la gama de colores CMYK
que se van a imprimir.

Más aún, si se envían los ficheros RGB
al RIP, no serán reconocidos como imá-
genes en color y se imprimirán como un
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Figura 5: Después de exportar el título del programa de dibujo
– en nuestro caso Inkscape – se abre con GIMP y se cambia a
imagen de 1 bit seleccionando Image>Mode>Indexed y esco-
giendo una paleta de 1 bit con “No Color Dithering”.

Figura 4: El título del East Belfast Observer.



film único. El resultado final será una
especie de imagen en escala de grises.

Usar colores CMYK significa que no se
acabará accidentalmente con una página
monocromo; el uso de un gestor de co-
lores significa que los colores que se ven
en las pruebas serán los mismos que los
del resultado final.

Elementos de la página
Las páginas consisten en tres elementos
básicos: textos, gráficos y espacios en
blanco. La proporción de cada uno de
ellos dependerá de lo que se esté di-
señando; la publicidad difiere de forma
significativa del contenido editorial y las
páginas de la editorial diferirán de publi-
cación a publicación e
incluso dentro de la misma
publicación.

Con algunas excepciones
notables, como el francés
Libération y el inglés
Guardian, el diseño de un
periódico no es nada ima-
ginativo. No es que los pe-
riódicos estén mal diseña-
dos, simplemente es que el
criterio es diferente del de
otras áreas del diseño grá-
fico.

Los dos aspectos claves
en el diseño de un periódi-
co son: la facilidad de lec-
tura y la facilidad de
maquetación. La primera
es importante porque un
periódico debe ser digerido
rápidamente por un lector
genérico, no por un espe-
cialista. Siendo consis-
tentes y ajustándonos a ciertas reglas
básicas harán que la tarea de lectura sea
bastante fácil. El otro aspecto es impor-
tante porque, a diferencia de las revistas,
que tienen una tirada mensual, los pe-
riódicos suelen ser diarios y suele haber
una presión significativamente alta sobre
el equipo de maquetación.

Para nuestro periódico de prueba, el
primer elemento va a ser el título (véase
la Figura 4). En este caso, las fuentes
usadas han sido Gill Sans Light Italic y
Gill Sans Bold Condensed.

Para nuestro periódico el título es un
fichero TIFF de alta resolución que se creó
en Inkscape, se exportó y se convirtió a un
TIFF de 1 bit a una resolución de 600 pun-

tos por pulgada (véase la Figura 5). 600dpi
es una resolución increíblemente alta,
especialmente teniendo en cuenta que la
prensa que vamos a usar imprime a unos
180dpi, entonces ¿por qué molestarnos
con esta resolución tan alta?

Los ficheros que usan un espacio de
color de 1 bit son en blanco y negro: no
son de escala de grises, sino literalmente
en blanco y negro. Hablando de forma
genérica, TIFFs de 1 bit se usan para
delineación. La ventaja de usar un espa-
cio de color de 1 bit es que el color de las
líneas (o en nuestro caso de los carac-
teres) pueden ser cambiados dentro de la
aplicación de maquetación, así que un
simple fichero fuente puede usarse para

múltiples variaciones de la
misma imagen. El lado
negativo de las imágenes
de 1 bit es que se
degradan a baja resolu-
ción. Incluso a 300dpi una
imagen de 1 bit empezará
a mostrar bordes rugosos.

Para importar el título,
seleccionamos Insert
Picture, el tercer icono de
la barra de herramientas y
dibujamos un marco que
ocupe el área entera
imprimible entre los dos
márgenes.

A continuación, selec-
cionamos File> Import
>Get Picture. Después de
seleccionar el fichero
apropiado, seleccionamos
Tools>Properties para lle-
gar al cuadro de diálogos
de Propiedades de Scribus

(véase la Figura 6) y seleccionamos
Image. Se selecciona la opción Scale to
Frame Size y nos aseguramos de que el
botón proportional esté marcado. El títu-
lo debería ahora tener el ancho de la
página frontal del periódico, excluyendo
los márgenes.

Encima del título hay tres cajas, que
resaltan el contenido dentro del periódico.
Estas cajas son marcos vacíos de imágenes
que han sido coloreados usando el cuadro
de diálogo Tools>Properties>Colors.
Directamente debajo del título están la
fecha y el número del periódico, además
del precio. Ambos han sido creados con
elementos de textos en Scribus de la forma
habitual. Es también posible crear el título
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como un marco de texto dentro de Scribus,
pero como es un elemento inalterable, es
mejor usar un fichero gráfico, ya que se
podría colar una errata con el tiempo.

El siguiente elemento a incluir es el
texto. En términos de entrada de texto,
es ineficiente introducirlo directamente
en Scribus. Incluso si se tiene un moni-
tor bastante grande, se perderá bas-
tante tiempo haciendo zoom para leer
las partes de las páginas. En vez de
ello, se debería preparar todo el texto a
introducir en un fichero con un proce-
sador de textos como el Writer de
OpenOffice, corregirlo, comprobando
las ortografía e importarlo posterior-
mente a Scribus.

En este punto se debería salvar el texto
como texto plano antes de importarlo a
Scribus. A partir de la versión 1.2.1,
Scribus ya puede importar texto directa-
mente de ficheros OpenOffice (.sxw). La
ventaja de esto es que se respetan las
características estéticas del original,
pudiendo importarse negritas, cursivas,
subrayados y, si Scribus apunta a los
mismo directorios de fuentes que
OpenOffice, el tipo de letra.

El próximo mes discutiremos en
detalle la forma de trabajar con el texto,
pero por ahora concentrémonos en con-
seguir incluir algún texto dentro de la
maqueta.

Conseguir meter el texto es tarea
fácil: seleccionamos el botón Insert Text
Frame de la barra de herramientas de
Scribus y dibujamos un marco en la
página, donde se quiera que el texto
aparezca. A continuación, selec-
cionamos File> Import> Get Text. El
texto del fichero seleccionado fluirá
dentro del marco seleccionado.

Para editar el texto, seleccionamos Edit
Contents of Frame de la barra de herra-
mientas y usamos el cursor con forma de
I para marcar el texto de la forma que se
desee como en cualquier procesador de
textos. Alternativamente, se puede usar
el Story Editor (también en la barra de
herramientas) para editar el texto.

Conclusión
Este artículo nos ha presentado Scribus,
una aplicación de maquetación con cali-
dad profesional de código abierto para
Linux. En el próximo número, aprende-
remos a manipular el texto y los gráficos
en el entorno de Scribus. ■

Figura 6: El cuadro de diálogo
de Propiedades de Scribus,
donde se ajusta casi
cualquier aspecto de un
objeto.


